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Chapter 457

Superiority by a
Margin Tests for the
Ratio of Two Poisson
Rates
Introduction
This procedure may be used to calculate power and sample size for superiority by a margin tests involving the ratio
of two Poisson rates. This procedure includes the option of accounting for over-dispersion.
The calculation details upon which this procedure is based are found in Zhu (2016). Some of the details are
summarized below.

Technical Details
Definition of Terms
The following table presents the various terms that are used.
Group

1 (Control)

2 (Treatment)

Sample size

𝑁𝑁1

𝑁𝑁2

Individual event rates

Dispersion parameter:
Average exposure time:
Superiority margin ratio:
Sample size ratio:

𝜆𝜆1

𝜆𝜆2

𝜑𝜑 (𝜑𝜑 > 1 implies over-dispersion; 𝜑𝜑 < 1 implies under-dispersion)

𝜇𝜇𝑡𝑡

𝑅𝑅0 (𝑅𝑅0 > 1 when higher rates are better; 𝑅𝑅0 < 1 when higher rates are worse)
𝜃𝜃 = 𝑁𝑁2 ⁄𝑁𝑁1
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Hypotheses
When higher rates are better, the superiority by a margin test hypotheses are
𝜆𝜆

𝜆𝜆

𝐻𝐻0 : 𝜆𝜆2 ≤ 𝑅𝑅0 vs. 𝐻𝐻1 : 𝜆𝜆2 > 𝑅𝑅0

where 𝑅𝑅0 > 1.

1

1

When higher rates are worse, the superiority by a margin test hypotheses are
𝜆𝜆

𝜆𝜆

𝐻𝐻0 : 𝜆𝜆2 ≥ 𝑅𝑅0 vs. 𝐻𝐻1 : 𝜆𝜆2 < 𝑅𝑅0

where 𝑅𝑅0 < 1.

1

1

Sample Size and Power Calculations
Sample Size Calculation
Zhu (2016) bases the sample size calculations on a non-inferiority test derived from a Poisson regression model.
The calculations for a superiority by a margin test are the same. The sample size calculation is
2

�𝑧𝑧𝛼𝛼 �𝑉𝑉0 + 𝑧𝑧𝛽𝛽 �𝑉𝑉1 �
𝑁𝑁1 ≥
(𝑙𝑙𝑙𝑙𝑙𝑙𝑅𝑅0 − log(𝜆𝜆2 ⁄𝜆𝜆1 ))2
𝑁𝑁2 = 𝜃𝜃𝑁𝑁1

where

𝑉𝑉1 =
and 𝑉𝑉0 may be calculated in either of two ways.

𝜑𝜑 1
1
� +
�
𝜇𝜇𝑡𝑡 𝜆𝜆1 𝜃𝜃𝜆𝜆2

𝑽𝑽𝟎𝟎 Calculation Method 1 (using assumed true rates)

Using Method 1, 𝑉𝑉0 and 𝑉𝑉1 are equal.

𝑉𝑉01 =

𝜑𝜑 1
1
� +
�
𝜇𝜇𝑡𝑡 𝜆𝜆1 𝜃𝜃𝜆𝜆2

𝑽𝑽𝟎𝟎 Calculation Method 2 (fixed marginal total or restricted maximum likelihood estimation)
𝑉𝑉02 =

𝜑𝜑(1 + 𝑅𝑅0 𝜃𝜃)2
𝜇𝜇𝑡𝑡 𝑅𝑅0 𝜃𝜃(𝜆𝜆1 + 𝜃𝜃𝜆𝜆2 )

Zhu (2016) did not give a recommendation regarding whether Method 1 or Method 2 should be used, except to
say that “sample sizes calculated using Method 2 are slightly larger compared to those calculated by Method 1 for
most simulated scenarios…”.

Power Calculation
The corresponding power calculation to the sample size calculation above is
𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 ≥ 1 − Φ �

�𝑁𝑁1 (𝑙𝑙𝑙𝑙𝑙𝑙𝑅𝑅0 − log(𝜆𝜆2 ⁄𝜆𝜆1 )) − 𝑧𝑧𝛼𝛼 �𝑉𝑉0
�𝑉𝑉1

�
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains the parameters associated with this test such as the Poisson rates, sample sizes, alpha, and
power.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters.

Test
Higher Poisson Rates Are
Specify whether higher Poisson rates are better or worse. This selection determines the direction of the null and
alternative hypotheses. When higher rates are better, the superiority by a margin test hypotheses are
H0: λ2 / λ1 ≤ R0 vs. H1: λ2 / λ1 > R0, and R0 > 1.
When higher rates are worse (lower are better), the superiority by a margin test hypotheses are
H0: λ2 / λ1 ≥ R0 vs. H1: λ2 / λ1 < R0, and R0 < 1.
Variance Calculation Method
Select among the two methods for calculating the V0 variance component (see the documentation above for
details).
•

Using Assumed True Rates
For this choice, the variance component V0 is based the values entered for λ1 and λ2.

•

Fixed Marginal Total or REML
This method assumes a fixed number of events. This method gives the same result as that derived using
restricted maximum likelihood estimation.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of
inferiority when in fact the treatment mean is non-inferior.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
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Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected. In this procedure, a type-I error occurs when rejecting the null hypothesis of inferiority
when in fact the treatment group is not inferior to the reference group.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

μ(t) (Average Exposure Time)
μ(t) (Average Exposure Time)
Enter a value (or range of values) for the average exposure (observation) time for each subject in each group. A
value of one is commonly entered when exposure times are all equal. The range is μ(t) > 0. You can enter a single
value such as 1 or a series of values such as 0.8 0.9 1 or 0.8 to 1.2 by 0.1.

Sample Size (When Solving for Sample Size)
Group Allocation
Select the option that describes the constraints on N1 or N2 or both.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both
sample sizes at once, no additional sample size parameters need to be entered.

•

Enter N2, solve for N1
Select this option when you wish to fix N2 at some value (or values), and then solve only for N1. Please note
that for some values of N2, there may not be a value of N1 that is large enough to obtain the desired power.

•

Enter R = N2/N1, solve for N1 and N2
For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2,
with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is
N2 = R * N1.

•

Enter percentage in Group 1, solve for N1 and N2
For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS
determines the needed N1 and N2 with this percentage to obtain the desired power.

N2 (Sample Size, Group 2)
This option is displayed if Group Allocation = “Enter N2, solve for N1”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.”
R is the ratio of N2 to N1. That is,
R = N2 / N1.
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Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this
ratio are considered.
N2 is related to N1 by the formula:
N2 = [R × N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1 (e.g., N1 =
10 and N2 = 20, or N1 = 50 and N2 = 100).
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for N1 and N2.”
Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for N1 and N2.
Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.

Sample Size (When Not Solving for Sample Size)
Group Allocation
Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. A single per group sample
size will be entered.

•

Enter N1 and N2 individually
This choice permits you to enter different values for N1 and N2.

•

Enter N1 and R, where N2 = R * N1
Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1.

•

Enter total sample size and percentage in Group 1
Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N,
and then N2 as N - N1.

Sample Size Per Group
This option is displayed only if Group Allocation = “Equal (N1 = N2).”
The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2
populations. Since the sample sizes are the same in each group, this value is the value for N1, and also the value
for N2.
The Sample Size Per Group must be ≥ 2. You can enter a single value or a series of values.
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N1 (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter N1 and N2 individually” or “Enter N1 and R, where N2 =
R * N1.”
N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
N2 (Sample Size, Group 2)
This option is displayed only if Group Allocation = “Enter N1 and N2 individually.”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter N1 and R, where N2 = R * N1.”
R is the ratio of N2 to N1. That is,
R = N2/N1
Use this value to obtain N2 as a multiple (or proportion) of N1.
N2 is calculated from N1 using the formula:
N2=[R x N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1.
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single value or a series of values.
Total Sample Size (N)
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of
the total sample size in Group 1, implicitly defines N1 and N2.
The total sample size must be greater than one, but practically, must be greater than 3, since each group sample
size needs to be at least 2.
You can enter a single value or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of
values.
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Effect Size
R0 (Superiority Margin Ratio)
Enter a value (or range of values) for the ratio of the two mean event rates assumed by the superiority by a margin
null hypothesis. The range of possible values depends on the test direction. When higher rates are better, the
superiority by a margin test hypotheses are H0: λ2 / λ1 ≤ R0 vs. H1: λ2 / λ1 > R0, and R0 > 1. When higher rates
are worse (lower are better), the superiority by a margin test hypotheses are H0: λ2 / λ1 ≥ R0 vs. H1: λ2 / λ1 < R0,
and R0 < 1.
λ1 (Event Rate of Group 1)
Enter a value (or range of values) for the mean event rate per time unit in group 1 (control).
Example of Estimating λ1
If 200 patients were exposed for 1 year (i.e. t1 = 1 year) and 40 experienced the event of interest, then the mean
event rate would be λ1 = 40/(200*1) = 0.2 per patient-year. If 200 patients were exposed for 2 years (i.e. t1 = 2
years) and 40 experienced the event of interest, then the mean event rate would be λ1 = 40/(200*2) = 0.1 per
patient-year. λ1 is used with λ2 to calculate the event rate ratio as λ2 / λ1. The range is λ1 > 0. You can enter a
single value such as 1 or a series of values such as 1 1.2 1.4 or 1 to 2 by 0.5.
Enter λ2 or Ratio for Group 2
Indicate whether to enter the Group 2 event rate (λ2) directly or the event rate ratio (λ2 / λ1) to specify λ2. The
event rate ratio is calculated from λ2 and λ1 as λ2 / λ1.
λ2 (Event Rate of Group 2)
Enter a value (or range of values) for the mean event rate per time unit in group 2 (treatment).
Example of Estimating λ2
If 200 patients were exposed for 1 year (i.e. t1 = 1 year) and 40 experienced the event of interest, then the mean
event rate would be λ2 = 40/(200*1) = 0.2 per patient-year. If 200 patients were exposed for 2 years (i.e. t1 = 2
years) and 40 experienced the event of interest, then the mean event rate would be λ2 = 40/(200*2) = 0.1 per
patient-year. λ1 is used with λ2 to calculate the event rate ratio as λ2 / λ1. The range is λ2 > 0. You can enter a
single value such as 1 or a series of values such as 1 1.2 1.4 or 1 to 2 by 0.5.
λ2 / λ1 (Ratio of Event Rates)
This is the (assumed, known, true) value of the ratio of the two event rates, λ1 and λ2, at which the power is to be
calculated. The event rate ratio is calculated from λ1 and λ2 as λ2 / λ1. The range is λ2 / λ1 > 0 and λ2 / λ1 ≠ R0.
When higher rates are better, λ2 / λ1 > R0 and R0 > 1. When higher rates are worse (lower are better), λ2 / λ1 <
R0, and R0 < 1. You can enter a single value such as 1 or a series of values such as 0.9 0.95 1 1.05 1.1 or 0.9 to
1.1 by 0.05.
φ (Dispersion)
Enter a value or series of values for the anticipated dispersion. Dispersion values lower than 1 indicate underdispersion, which implies the variance is less than the mean. Dispersion values greater than 1 indicate overdispersion, which implies the variance is greater than the mean. If over-dispersion or under-dispersion are not
anticipated, enter a value of 1. You can enter a single value such as 1 or a series of values such as 0.9 0.95 1 1.05
1.1 or 0.9 to 1.1 by 0.05.
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Example 1 – Calculating Sample Size
Researchers wish to determine whether the average Poisson rate of those receiving a new treatment is more than
10% lower than the current control. In the scenario, lower Poisson rates are better than higher rates. The average
exposure time for all subjects is 1.8 years. The event rate of the control group is 2.6 events per year. The
researchers would like to examine the effect on sample size of a range of treatment group event rates from 2.2
down to 1.5. Over-dispersion is not anticipated.
The desired power is 0.9 and the significance level will be 0.025. The variance calculation method used will be
the method where the assumed rates are used.

Setup
This section presents the values of each of the parameters needed to run this example. First load the Superiority
by a Margin Tests for the Ratio of Two Poisson Rates procedure window from the menus. You may then make
the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open
Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Higher Poisson Rates Are ...................... Worse
Variance Calculation Method .................. Using Assumed True Rates
Power ...................................................... 0.90
Alpha ....................................................... 0.025
μ(t) (Average Exposure Time) ................ 1.8
Group Allocation ..................................... Equal (N1 = N2)
R0 (Superiority Margin Ratio) ................. 0.9
λ1 (Event Rate of Group 1) ..................... 2.6
Enter λ2 or Ratio for Group 2 ................. λ2 (Event Rate of Group 2)
λ2 (Event Rate of Group 2) ..................... 1.5 to 2.2 by 0.1
φ (Dispersion) ......................................... 1

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Superiority by a Margin Tests of the Ratio of Two Poisson Rates
Test Direction Assumption: Higher Poisson Rates Are Worse
H0: λ2 / λ1 ≥ R0 vs. H1: λ2 / λ1 < R0
Variance Calculation Method: Using Assumed True Rates
Grp 1
Grp 2
Average
Cntrl
Trt
Event
Exposure
Event
Event
Rate
Time
Rate
Rate
Ratio
Power
N1
N2
N
μ(t)
λ1
λ2
λ2 / λ1
0.90851
32
32
64
1.80
2.60
1.50
0.577
0.90151
41
41
82
1.80
2.60
1.60
0.615
0.90190
56
56
112
1.80
2.60
1.70
0.654
0.90096
80
80
160
1.80
2.60
1.80
0.692
0.90102
123
123
246
1.80
2.60
1.90
0.731
0.90069
210
210
420
1.80
2.60
2.00
0.769
0.90059
430
430
860
1.80
2.60
2.10
0.808
0.90021
1288
1288
2576
1.80
2.60
2.20
0.846

Superiority
Margin
Ratio
R0
0.900
0.900
0.900
0.900
0.900
0.900
0.900
0.900

Dispersion
φ
1.00
1.00
1.00
1.00
1.00
1.00
1.00
1.00

Alpha
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
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Report Definitions
Power is the probability of rejecting the null hypothesis when it is false.
N1 and N2 are the number of subjects in groups 1 and 2, respectively.
N is the total sample size. N = N1 + N2.
μ(t) is the average exposure (observation) time across subjects in both groups.
λ1 is the event rate per time unit in Group 1 (control).
λ2 is the event rate per time unit in Group 2 (treatment).
λ2 / λ1 is the (known, true, assumed) ratio of the two event rates.
Dispersion (φ) is the dispersion parameter (φ > 1 implies over-dispersion, φ < 1 implies under-dispersion).
R0 is the superiority margin (null hypothesis) ratio.
Alpha is the probability of rejecting the null hypothesis when it is true.
Summary Statements
For a test of H0: λ2 / λ1 ≥ 0.900 vs. H1: λ2 / λ1 < 0.900 (assuming higher Poisson rates are
worse), and using the variance calculation method with assumed true rates, samples of 32 and 32
subjects with average exposure time 1.80 achieve 90.851% power to detect an event rate ratio λ2
/ λ1 of 0.577 when the event rate in group 1 (λ1) is 2.60, the event rate in group 2 (λ2) is
1.50, the dispersion is 1.00, and the significance level (alpha) is 0.025.
Dropout-Inflated Sample Size

Dropout Rate
20%
20%
20%
20%
20%
20%
20%
20%

──── Sample Size ────
N1
N2
N
32
32
64
41
41
82
56
56
112
80
80
160
123
123
246
210
210
420
430
430
860
1288
1288
2576

Dropout-Inflated
Enrollment
──── Sample Size ────
N1'
N2'
N'
40
40
80
52
52
104
70
70
140
100
100
200
154
154
308
263
263
526
538
538
1076
1610
1610
3220

Expected
Number of
───── Dropouts ─────
D1
D2
D
8
8
16
11
11
22
14
14
28
20
20
40
31
31
62
53
53
106
108
108
216
322
322
644

Definitions
Dropout Rate (DR) is the percentage of subjects (or items) that are expected to be lost at random during the
course of the study and for whom no response data will be collected (i.e. will be treated as "missing").
N1, N2, and N are the evaluable sample sizes at which power is computed. If N1 and N2 subjects are evaluated
out of the N1' and N2' subjects that are enrolled in the study, the design will achieve the stated power.
N1', N2', and N' are the number of subjects that should be enrolled in the study in order to end up with N1,
N2, and N evaluable subjects, based on the assumed dropout rate. After solving for N1 and N2, N1' and N2'
are calculated by inflating N1 and N2 using the formulas N1' = N1 / (1 - DR) and N2' = N2 / (1 - DR), with
N1' and N2' always rounded up. (See Julious, S.A. (2010) pages 52-53, or Chow, S.C., Shao, J., and Wang, H.
(2008) pages 39-40.)
D1, D2, and D are the expected number of dropouts. D1 = N1' - N1, D2 = N2' - N2, and D = D1 + D2.

This report shows the sample sizes for the indicated scenarios.
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Plots Section

This plot represents the required sample sizes for various values of λ2.

Example 2 – Validation
We did not find a publication with an example of a superiority by a margin test for the ratio of two Poisson rates.
However, Examples 2 and 3 of the Non-Inferiority Tests for the Ratio of Two Poisson Rates chapter use the same
formulas and calculations as those used in this procedure. We refer the reader to those examples for validation of
this procedure.
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